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Pos: 1 /TD/Überschriften/MUF/Sicherheit und Umwelt @ 3\mod_1234793958627_79.doc @ 26223 @ 1 
 

1 Safety and the environment 
Pos: 2 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Elektrische Gefahren vermeiden @ 3\mod_1234794609299_79.doc @ 26280 @ 5  

Avoiding electrical hazards 
> Never use the instrument and connected probes to measure on 

or near live parts! 
> Damaged mains cables must only be replaced by authorized 

personnel. 
> Only have the transmitter wired and connected by authorized 

personnel with the voltage disconnected. 
> You must always comply with the regulations applicable in your 

country for opening and repairing electrical equipment. 
Pos: 3 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Personen- und Sachschäden vermeiden @ 3\mod_1234794744768_79.doc @ 26299 @ 5 
 

Avoiding personal injury and damage to equipment 
> Installation, setting and calibration work must only be carried 

out by qualified and authorized personnel! 
> Only open the instrument when this is expressly described in 

the instruction manual for installation, maintenance or repair 
purposes. 

> Observe the permissible storage, transport and operating 
temperature. 

Pos: 4 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nicht mit Lösungsmitteln lagern @ 0\mod_1175692375179_79.doc @ 583 @  
 

> Do not store the product together with solvents. Do not use any 
desiccants. 

Pos: 5 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Bei Wartung MUF nicht zur Regelung verwenden @ 3\mod_1234794852377_79.doc @ 26318 @  
 

> Do not use the instrument for control purposes at the same time 
as operating or servicing the transmitter. 

Pos: 6 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Produkt bestimmungsgemäß verwenden @ 0\mod_1173781261848_79.doc @ 386 @  
 

> Only operate the product properly, for its intended purpose and 
within the parameters specified in the technical data. Do not 
use any force. 

Pos: 7 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/Nur beschriebene Wartungsarbeiten durchführen @ 0\mod_1175692705195_79.doc @ 601 @  
 

> Carry out only the maintenance and repair work on this 
instrument that is described in the documentation. Follow the 
prescribed steps exactly. Use only original spare parts from 
Testo.  

Pos: 8 /TD/Sicherheit und Umwelt/Sicherheit gewährleisten/MUF 63xx/Fachpersonal @ 3\mod_1234794940409_79.doc @ 26337 @  
 

Any additional work must only be carried out by authorized 
personnel. Otherwise testo will not accept any responsibility for the 
proper functioning of the instrument after repair and for the validity 
of certifications. 
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Pos: 9 /TD/Überschriften/MUF/Umwelt schützen @ 3\mod_1234858757571_79.doc @ 26363 @ 5 
 

Protecting the environment 
Pos: 10 /TD/Sicherheit und Umwelt/Umwelt schützen/Produkt entsorgen @ 0\mod_1173780307072_79.doc @ 357 @   

> At the end of its useful life, send the product to the separate 
collection for electric and electronic devices (observe local 
regulations) or return the product to Testo for disposal.  

Pos: 11 /TD/Überschriften/MUF/Zu diesem Dokument @ 3\mod_1234793991331_79.doc @ 26242 @ 1 
 

2 About this document 
Pos: 12 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Verwendung (Standard) @ 0\mod_1173775068554_79.doc @ 337 @ 5 
 

Use 
> Please read this documentation through carefully and 

familiarize yourself with the product before putting it to use. Pay 
particular attention to the safety instructions and warning advice 
in order to prevent injuries and damage to the products. 

> Keep this document to hand so that you can refer to it when 
necessary.  

> Hand this documentation on to any subsequent users of the 
product. 

Pos: 13 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis WARNUNG @ 2\mod_1207646966234_79.doc @ 14398 @   

 WARNING Indicates potential serious injuries 
 Pos: 14 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonventionen/Warnhinweis VORSICHT @ 2\mod_1207651416515_79.doc @ 14416 @  
 

 CAUTION indicates potential minor injuries 
 
Pos: 15 /TD/Sicherheit und Umwelt/Zu diesem Dokument/Symbole und Schreibkonv. Software [Standard] @ 0\mod_1190203332543_79.doc @ 4883 @ 5  

Symbols and writing standards 
 

Representa-
tion  

Explanation  

 
Note: Basic or further information. 

1. ... 
2. ... 

Action: more steps, the sequence must be 
followed. 

> ... Action: a step or an optional step. 
- ... Result of an action. 
Menu Elements of the program interface. 
[OK] Buttons of the program interface.  
... | ... Functions/paths within a menu. 
“...” Example entries 

 
Pos: 16 /TD/--- Seitenwechsel --- @ 0\mod_1173774430601_0.doc @ 283 @  
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Pos: 17 /TD/Überschriften/MUF/Inhalt @ 3\mod_1234794019831_79.doc @ 26261 @ 1  
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Pos: 19 /TD/Überschriften/MUF/1 Messumformer @ 3\mod_1234258401060_79.doc @ 23894 @ 1  

4 Transmitter 
Pos: 20 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

4.1. Specifications 
Pos: 21 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 635x @ 3\mod_1234444589072_79.doc @ 25059 @ 3 
 

4.1.1. Functions and use 
The testo 6351 transmitter is suitable for the following applications, 
amongst others: 
• Test benches 
• Clean rooms 
•  Filling processes 
• Complex room climate applications 
•  Monitoring flow velocities or volumetric flow rates in air 

conditioning systems 
Pos: 22 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 63xx ohne Ethernet @ 3\mod_1234444980038_79.doc @ 25098 @ 3  

4.1.2. Scope of delivery 
The scope of delivery of the testo 6351 transmitter includes the 
following: 
• Key cover 
• Rear panel bracket 
• Instruction manual 
• Calibration report 
• CD-ROM with operating instructions (PDF), configuration files 

for Ethernet module and P2A update (this can only be used in 
conjunction with the P2A software, which has to be ordered 
separately). 

Pos: 23 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/Zubehör Übersicht 635x @ 3\mod_1236084601953_79.doc @ 27292 @ 3 
 

4.1.3. Accessories 
The following accessories are available for the testo 6351 
transmitter, amongst others: 
•  Mains unit 
• P2A software (parameterizing, adjusting and analyzing 

software) 
• Assembly accessories 

 

 
Information about accessories and their order numbers can 
be found in Accessories and spare parts or on the 
website at www.testo.com. 
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Pos: 24 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 635x @ 3\mod_1236164155689_79.doc @ 27353 @ 35555555555555555555  

4.1.4. Technical data 
Parameter 
• Differential pressure 

Accuracy 
 

 
The specifications are only valid if the positive pressure is 
applied at the positive pressure connection. 

 

• ±0.8 % of measuring range final value, additional ±0.3 Pa 
intrinsic error1 

• TK slope drift = 0.03 % of measuring range per degree Kelvin of 
deviation from nominal temperature 22 °C 

• TK zeroing drift= 0 %, as zeroing with solenoid valve2 

Measuring range, resolution and overload 
Measuring range 
depending on 
resolution ordered 

Resolution Overload 

0 to 50 Pa 0.1 Pa 20,000 Pa 
0 to 100 Pa 0.1 Pa 20,000 Pa 
0 to 500 Pa 0.1 Pa 20,000 Pa 
0 to 10 hPa 0.01 hPa 200 hPa 
0 to 50 hPa 0.01 hPa 750 hPa 
0 to 100 hPa 0.1 hPa 750 hPa 

                                                           
1 Measuring uncertainty in accordance with GUM: ±0.8 % of measuring range 
final value ±0.3 Pa.  
GUM (Guide to the Expression of Uncertainty in Measurement): ISO guideline for determining the 
measuring uncertainty in order to render global measurement results comparable.  

The following uncertainties are used during the inquiry: 

• Hysteresis 

• Linearity 

• Reproducibility 

• Adjustment area/factory calibration 

• Test location 
2 Minor mixtures of the media may occur at the positive and negative pressure 
side due to the automatic zeroing cycle. 
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Measuring range 
depending on 
resolution ordered 

Resolution Overload 

0 to 500 hPa 0.1 hPa 2500 hPa 
0 to 1000 hPa 1 hPa 2500 hPa 
0 to 2000 hPa 1 hPa 2500 hPa 
-50 to 50 Pa 0.1 Pa 20,000 Pa 
-100 to 100 Pa 0.1 Pa 20,000 Pa 
-500 to 500 Pa 0.1 Pa 20,000 Pa 
-10 to 10 hPa 0.01 hPa 200 hPa 
-50 to 50 hPa 0.01 hPa 750 hPa 
-100 to 100 hPa 0.1 hPa 750 hPa 
-500 to 500 hPa 0.1 hPa 2500 hPa 
-1000 to 1000 hPa 1 hPa 2500 hPa 
-2000 to 2000 hPa 1 hPa 2500 hPa 

 
Upon delivery and following a factory reset the readings are 
shown in the display in the unit that was ordered via the 
KMAT option Fxx, see Ordering options for testo 6351 
transmitter (0555 6351), page 80.  

Meas. cycle 
• 1/sec 

Interface 
• Mini-DIN for P2A software (adjustment and parameterization 

software)  
• optional: Ethernet module 

Voltage supply 
•  4-wire (separate signal and supply lines): 20 to 30 V AC/DC, 

300 mA power consumption 

Maximum load 
• 4-wire: 500 Ω (power output) 
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Maximal load 
• 4-wire: 10 kΩ (voltage output) 

Analog output 
•  0 to 1 V ± 1.5 mV (4-wire) or 
• 0 to 5 V ± 7.5 mV (4-wire) or 
• 0 to 10 V ± 15 mV (4-wire) or 
• 0 to 20 mA ± 0.03 mA (4-wire) or 
• 4 to 20 mA ± 0.03 mA (4-wire) 
• TK = 0.05 %K of measuring range per degree Kelvin of 

deviation from nominal temperature 22 °C 

Resolution of analog output 
• 12 bit 

Relay 
• 4 relays, 250 V AC/DC, 3 A (optional) 

Display 
• 2-line LCD with plain text line (optional) 

Operating temperature  
• -5 to 50 °C/23 to 122 °F 
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Storage temperature 
• -20 to 60 °C/-4 to 140 °F 

Process temperature 
• -20 to 65 °C/-4 to 149 °F 

Housing, weight 
• Plastic, 0.7 kg 
• Optional Ethernet intermediate layer: 0.6 kg 

Protection class 
• IP 65 only if the transmitter is wired and/or sealing plugs are 

inserted 

Directives, standards and tests 
• EC Directive: 2004/108/EC 

Warranty 
• Duration: 2 years 
• Warranty conditions: see website www.testo.com/warranty 

Pos: 25 /TD/Leistungsbeschreibung/Technische Daten/MUF 63xx/MUF 63xx Abmessungen @ 3\mod_1234450671494_79.doc @ 25194 @ 3 
 

4.1.5. Dimensions 
 

  

 

Dimensions in mm a b  
with M20 cable couplings 144 147 
With NPT cable coupling 144 144 
With M plug-in connection 143  
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Pos: 26 /TD/Überschriften/MUF/1.2/2.2 Produktbeschreibung @ 3\mod_1234258723551_79.doc @ 24008 @ 2  

4.2. Product description 
Pos: 27 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Auf einen Blick 635x @ 3\mod_1236073473199_79.doc @ 27103 @ 3 
 

4.2.1. At a glance 
 

1 Keys (only with optional 
display) 

2 Service flap screw 
connection (self-locking, 
2 pcs.) 

3 Display (optional) 
4 Service flap 
5 Negative pressure 

connection 
6 Positive pressure connection, 

marked with a red washer 
7 Lower part of housing 
8 M 16 x 1.5 screw 

connection*, e.g. analog 
outputs 

9 M 16 x 1.5 screw 
connection*, e.g. voltage 
supply 

10 Eyelet for measuring point 
panel 

11 M 20 x 1.5 screw 
connection*, e.g. R3 and R4 
relays 

12 M 20 x 1.5 screw 
connection*, e.g. R1 and R2 
relays 

13 Adjusted probe plug (non-
functional probe socket) 

14 Upper part of housing 
* Alternatively, NPT cable 

couplings or M plug-in 
connections are available 
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15 Housing screws 

16 Hole for fastening to rear 
panel bracket (M3 x 6 screw) 

 

17 Plastic bracket for assembly 
on rear panel 

 
Pos: 28 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Display und Tastatur @ 3\mod_1234773965059_79.doc @ 25650 @ 3 
 

4.2.2. Display and keypad 
The display option allows operation of the testo 6351 transmitter via 
the display and four keys. 
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The LCD display consists of two 7-segment lines for displaying 
readings and units and of an information line (for status messages, 
for example). 
The brightness and contrast of the display and the background 
lighting (permanent or off) can be changed via the user menu or the 
P2A software. 

Pos: 29 /TD/Überschriften/MUF/1.2.x Serviceschnittstelle @ 3\mod_1237306891654_79.doc @ 29795 @ 3 
 

4.2.3. Service interface 
Pos: 30 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Serviceschnittstelle 635x @ 3\mod_1237217388492_79.doc @ 29723 @  
 

The parameterizing socket (mini-DIN) is located behind the service 
flap as an interface to the P2A software. 

Pos: 31 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Relaisplatine (Option) @ 3\mod_1234774184843_79.doc @ 25688 @ 3 
 

4.2.4. Relay board (option) 
This has a floating switch capacity of 250 V AC/3 A. The switching 
limits and hysteresis as well as the function as relay for the 
collective alarm can be set via the display or the P2A software. 
Further features include: 
• Function of changeover contacts (NC/NO contacts) freely 

selectable 
• 12 terminals for a total of 4 relays. 

 

 
If no relays are available, settings for monitoring limit values
or alarms can still be controlled via the display. The alarm 
status will be shown on the display. 

  

 
Only have the transmitter wired and connected by 
authorized personnel with the voltage disconnected. 

 
Pos: 32 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Analogausgänge 635x @ 3\mod_1234774510463_79.doc @ 25726 @ 3 
 

4.2.5. Analog outputs 
As analog outputs, the testo 6351 has either 
• 1 current output of 0 to 20 mA (4-wire)/4 to 20 mA (4-wire) or 
• 1 voltage output of 0 to 1 V/0 to 5 V/0 to 10 V (4-wire) 

 
 Pos: 33 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Messgrößen 635x @ 3\mod_1234775082160_79.doc @ 25764 @ 3 
 

4.2.6. Parameters 
The following parameters are displayed: 
• Differential pressure in Pa, hPa, kPa, mbar, bar, mmH2O, inch 

H2O, inch HG, kg/cm2, PSI 
• Flow3 in m/s, ft/min  

                                                           
3 To prevent fluctuating flow rate values at the zero point (depressurized), the 
flow rate values are only calculated as of differential pressures > 0.2 Pa or 
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• Volumetric flow rate4 in m3/h, l/min, Nm3/h, Nl/min 
•  Pos: 34 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Skalierung @ 3\mod_1234775406989_79.doc @ 25783 @ 3 
 

4.2.7. Scaling 
There are three types of min./max. values: 
1 The measuring range: The maximum sensor performance is in 

this range. Values outside of the measuring range are displayed 
via messages, for example. Measuring range, see table 
(below). 

2 Standard scaling: The output signals are assigned to this 
measuring range as standard: 
◦ during delivery if no entries are made in the order code 
◦ after exchanging the unit, the measuring range recorded in 

the instrument is applied as standard. 
 

 
The transmitter even retains its scaling with the voltage 
disconnected. 

 

Measuring range, see table (below). 
3 The maximum settings for the manual scaling  

◦ The maximum limits can be calculated as follows: 
 X = difference between MIN. and MAX. value of the 

standard scaling 
 (Max. value of standard) + (50 % of X) 
 (Min. value of standard) - (50 % of X) 
◦ It is thus possible to scale beyond the measuring range, e.g. 

for the adjustment of the scaling limits to standard values of 
a PLC. 

With the alarm definition, however, the physical measuring 
range limits are decisive. 

 
 
Pos: 35 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Tabelle Skalierung MUF 635x @ 3\mod_1236343891632_79.doc @ 27483 @   

Measuring 
range/standard scaling 

Maximum scaling 

0 to 50 Pa -25 to 75 Pa 
0 to 100 Pa -50 to 150 Pa 
0 to 500 Pa -250 to 750 Pa 
0 to 10 hPa -5 to 15 hPa 

                                                                                                                                 
> 0.1 % of the respective measuring range (whichever is the greater). With 
smaller differential pressures, the flow rate value remains at 0.00 m/s. 
4 Calculated 
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Measuring 
range/standard scaling 

Maximum scaling 

0 to 50 hPa -25 to 75 hPa 
0 to 100 hPa -50 to 150 hPa 
0 to 500 hPa -250 to 750 hPa 
0 to 1000 hPa -500 to 1500 hPa 
0 to 2000 hPa -1000 to 3000 hPa 
-50 to 50 Pa -100 to 100 Pa 
-100 to 100 Pa -200 to 200 Pa 
-500 to 500 Pa -1000…1000 
-10 to 10 hPa -20 to 20 hPa 
-50 to 50 hPa -100 to 100 hPa 
-100 to 100 hPa -200 to 200 hPa 
-500 to 500 hPa -1000 to 1000 hPa 
-1000 to 1000 hPa -2000 to 2000 hPa 
-2000 to 2000 hPa -4000 to 4000 hPa 

 
Pos: 36 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Alarmbehandlung @ 3\mod_1234776787635_79.doc @ 25821 @ 3  

4.2.8. Alarm handling 
For upper and lower alarm limits, individual alarms as well as 
collective alarms can be specified. If the collective alarm function is 
activated, an alarm is triggered as soon as the alarm limit of an 
alarm is exceeded, if this alarm is assigned to the collective alarm. 
The testo 6351 monitors limit values with the help of relays. If a 
reading is outside the limit values, a relay to be specified by the 
user is switched. 
If the reading reverts to more than a specified hysteresis below or 
above the limit value, the alarm is cancelled. 
In addition, information about the occurrence of error/status 
messages can be provided by means of a collective alarm relay, 
see Status, warning and error messages, page 47  

 

 
If multiple alarm messages are activated at the same time, 
the last alarm is shown. If the alarm is cancelled again, the 
previous messages are no longer shown. 
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Pos: 37 /TD/Überschriften/MUF/1.3/2.3 Inbetriebnahme @ 3\mod_1234258805768_79.doc @ 24027 @ 2  

4.3. Commissioning 
Pos: 38 /TD/Erste Schritte/MUF 63xx/Wandmontage 635x_6321 @ 3\mod_1236065568006_79.doc @ 27063 @ 3455 
 

4.3.1. Assembling the instrument 
4.3.1.1. Wall mounting 

Attaching rear panel bracket 
 

 

1. Remove locking screw (see item (4) of drawing below) and 
detach rear panel bracket from plastic bracket (see item (2) of 
drawing below). 

2. Hold rear panel bracket in assembly position and mark the three 
drill holes. 

3. Drill three holes (Ø 5 mm) and insert dowels where necessary. 
4. Screw on rear panel bracket. 

Remember that the clamping brackets (1) must face the wall. 

Fastening instrument to rear panel bracket 



4 Transmitter 

  19 

 

1. Slide plastic bracket (2) on the back of instrument onto rear 
panel bracket until it engages (see arrows). 

2. Insert screw (4) through hole (3) and screw into rear panel 
bracket. 

Pos: 39 /TD/Erste Schritte/MUF 63xx/Gerät anschließen @ 3\mod_1234779466958_79.doc @ 25878 @ 35 
 

4.3.2. Connecting the instrument 
Opening the instrument 

 

  

1. Loosen screw connection (1) of service flap and open the flap. 
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2. Loosen and remove housing screws (2). 
3. Remove upper part of housing from lower part (3) and place on 

a clean surface. 
 

WARNING
Electrical voltage 
Danger of injury! 
> De-energize the mains connection before connecting the 

transmitter. 
 

  

 
Only have the transmitter wired and connected by 
authorized personnel with the voltage disconnected. 
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Pos: 40 /TD/Erste Schritte/MUF 63xx/Anschlussübersicht 635x @ 3\mod_1234780293877_79.doc @ 25916 @ 4  

4.3.2.1. Overview of terminals 
 

 

 

1 Lower part of housing 6 Terminal board 
2 Relay board (option) 7 M 16 x 1.5 screw connection*
3 Relay terminals 8 Eyelet for measuring point 

panel 
4 Insulating trough for relay 

board 
9 M 20 x 1.5 screw connection*

5 Terminal strip for voltage 
supply and analog outputs 

* Alternatively, NPT cable 
coupling or M plug-in 
connection 

 

 
The following description of the terminals refer to this 
overview and its numbering. 
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 Pos: 41 /TD/Erste Schritte/MUF 63xx/Spannungsversorgung/Analogausgänge anschließen 635x @ 3\mod_1234786177781_79.doc @ 25973 @ 45 
 

4.3.2.2. Connecting voltage supply and analog outputs 
 

 

Terminal strip for voltage 
supply and analog outputs, 
item (5) of overview of 
terminals, page 21  

 

 
Channels 2 and 3 shown on the circuit board cannot be 
used with this instrument. 

 

1. Disconnect connector. 
2. Strip the cable ends, clamp wire end ferrules on and screw 

down onto voltage terminals. 
3. Insert connector into socket. 

 

Wiring diagram for 4-wire system (0 to 20 mA/4 to 20 mA/0 to 
1 V/0 to 5 V/0 to 10 V) 

1-channel 
0 to 20 mA/4 to 20 mA 
max. load per 500 Ω 
0 to 1 V/0 to 5 V/0 to 10 V 

 

 
Channels 2 and 3 shown on the circuit board cannot be 
used with this instrument. 

  

 
Requirement for the connecting cable of the supply: 
• Insulated with cross-section of at least 0.25 mm², 

maximum 2.7 mm² without wire end sleeves. 
• The supply line must be secured against exceeding 8 A. 
• An OFF switch must be installed in an easily accessible 

position close by and be marked as such. 
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1. Disconnect connector. 
2. Strip the cable ends, clamp wire end ferrules on and screw to 

channel terminals as shown in diagram. 
3. Insert connector into socket. 

Pos: 42 /TD/Erste Schritte/MUF 63xx/Relaisausgänge anschließen @ 3\mod_1234786460813_79.doc @ 25992 @ 455555  

4.3.2.3. Connecting the relay outputs 
 

 
Only have the transmitter wired and connected by 
authorized personnel with the voltage disconnected. 

 

Relay terminal strip, 
item (3) of overview of 
terminals  

There is the option of twelve terminals for a total of four relays. The 
designations NC/C/NO (normally closed contact/root or 
pin/normally open contact) are etched on the surface of the board. 

Using PG screw connection 
1. Feed connection cables for the relays through opened 

M 20 x 1.5 screw connection (item (10) of overview of 
terminals). 

2. Strip cable ends and clamp on wire end ferrules. 
3. Connect relays according to chosen function (NC/NO) (see 

diagrams below; relay 1 is shown as an example of a 
connection). 

Using plug-in connections (optional) 
 

 
Only insert or disconnect the plug-in connection when the 
voltage is disconnected. 

 

4. Clean the connector of the probe line and the coupling of any 
foreign matter. 

 

 
Do not disconnect the connector of the probe line from the 
instrument for extended periods to protect against 
contamination. 
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Connection note 
 

 

 

 
• For the connection, a double-insulated mains cable 

(sheathed cable) with a cross-section of at least 
1.5 mm² must be used. 

• Cable connection (2) may not be routed in a loop within 
the tray (1). 

• It is recommended that you always tie 3 cores to one 
another using a cable tie (3). 

• The insulation of the cable must be fed at least 5 mm 
(4) into the tray. 
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Use of relay as NC contact (NC = normally closed) 
1 Alarm/status light 

(example of installation)
2 250 V AC/DC, 3 A 

 

 
The busy light (alarm/status light) is permanently on until 
the relay opens or the circuit is interrupted. This circuit can 
therefore be used to monitor the functionality of the alarm 
circuit, as a cable break, for instance, is indicated by the 
busy light going off. 

 

Use of relay as NO contact (NO = normally open) 
1 Alarm/status light 

(example of installation)
2 250 V AC/DC, 3 A 
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The busy light (alarm/status light) only comes on when the 
relay is switched (closed). Monitoring the functionality of the 
alarm circuit is therefore not possible with this switching 
operation. 

 

5.  Close M 20 x 1.5 screw connection (item (9) in overview of 
terminals). 

Pos: 43 /TD/Erste Schritte/MUF 63xx/Option Steckerverbindung 635x @ 3\mod_1237387714896_79.doc @ 30053 @ 45 
 

4.3.2.4. Plug-in connection option 
As an option, the PG screw connections of the signal and supply 
lines can be replaced with plug-in connections that are installed at 
the housing, see item 1 and 2. The relay cabling occurs via 
standard cable entries and PG screw connections. 

 

 

Plug-in connections for power supply and channels 
M12 plug-in connection (5-pin) socket (item 1) 
View of the plug-in connections in the installed state from outside 

 

PIN Assignment 
1 V 24- 
2 V 24+ 
3 + Ch1 
4 - Ch1 

 5 PE 
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Pos: 44 /TD/Erste Schritte/MUF 63xx/Gerät schließen @ 3\mod_1234788511529_79.doc @ 26030 @ 4  

4.3.2.5. Closing the instrument 
 

 

1. Place upper part of instrument on top of lower part (see arrow) 
and fix in place with housing screws (1). 
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2. Close the service flap and tighten screws (2). 
Pos: 45 /TD/Überschriften/MUF/1.3.3 Gerät abgleichen @ 3\mod_1236081099337_79.doc @ 27173 @ 3  
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4.3.3. Adjusting the instrument 
Pos: 46 /TD/Erste Schritte/MUF 63xx/Analogausgangs-Abgleich 635x @ 3\mod_1237373284088_79.doc @ 29825 @ 45 
 

4.3.3.1. Analog output adjustment 
The purpose of adjusting the analog outputs is to adjust the signal 
chain from the digital signal (within the transmitter) to the analog 
outputs. The signal type that was appointed for the transmitter is 
adjusted respectively for each channel (e.g. 4 to 20 mA or 0 to 1 V, 
etc.). 

 

1 Status LED 
2. Contact ch. 1+ 
3. Contact ch. 1- 
4. Service interface 

Adjusting analog output 1 

✓  With testo 6351 with current output: Load of max. 500Ω is 
connected to channel 1 (see Plug-in connections for power 
supply and channels, page 26) 

✓  A precise multimeter (minimum requirement: resolution 6.5 
digits, at least 5-times more accurate than the 6351) is 
available. 

 

 
If only a simple multimeter is available, the analog output 
must not be adjusted. 

 

✓  The service flap is open. 

1. Connect the inputs of the multimeter with the contacts (2) and 
(3) for channel 1. 
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2. Transfer the reference analog value measured with the 
multimeter into the P2A software (see Adjusting the analog 
output, page 74) or enter it via the user menu (see Performing 
analog adjustment, page 45). 

3. Disconnect connections between the multimeter and the 
contacts of the testo 6351 and close the service flap. 

Pos: 47 /TD/Erste Schritte/MUF 63xx/n-Punkt-Abgleich _635x @ 3\mod_1236352382511_79.doc @ 27522 @ 4 
 

4.3.3.2. n-point adjustment 
With an n-point adjustment, the parameters at the 3-6 
measurement points are adjusted to the reference value. The 
reference conditions are obtained by using a precise pressure 
sensor that should be 5-times more accurate than the transmitter. 

 

1 Positive pressure connection 
2. Negative pressure connection 

 

3. Pressure sensor 

 

 
The number of measuring points is set to 3 by the factory 
and can only be changed using the P2A software (see n-
point adjustment, page 73). 

 

 
The n-point adjustment must always be carried out to its full 
extent and in good time at all selected measurement points. 

 
 

✓  A precise pressure sensor (5-times more accurate than the 
transmitter, e.g. DPC precision pressure sensor from testo 
industrial services) is available. 

  

1. Connect the positive output of the pressure sensor (3) to the 
positive pressure connection of the transmitter (1) and the 
negative output of the pressure sensor (3) to the negative 
pressure connection of the transmitter (2). 

2. Transfer the reference pressure value created with the pressure 
sensor into the P2A software (see n-point adjustment, page 73) 
or enter it via the user menu (see Performing analog 
adjustment, page 45). 

3. Repeat step 2 for all of the measuring points. 
4. Disconnect connections between the pressure sensor and the 

pressure connections of the testo 6351. 
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Pos: 48 /TD/Überschriften/MUF/1.4 Bedienung @ 3\mod_1234443160034_79.doc @ 25001 @ 2 
 

4.4. Operation 
Pos: 49 /TD/Produkt verwenden/MUF 63xx/Zusammenhang Bedienmenü – Mini DIN Buchse aktiv @ 3\mod_1234454016014_79.doc @ 25213 @ 3  

4.4.1. Relationship between user menu and mini-DIN 
socket is active 
The testo 6351 can be parameterized using either the user menu or 
the P2A software (see Parameterizing, adjusting and analyzing 
software (P2A software) page 53). 

 

 
The testo 6351 transmitter can only be operated via the 
display and keypad if the display option is available. 
If the testo 6351 is connected to the P2A software, the user 
menu is blocked for the duration of the communication. The 
message Service plug is shown in the display of the testo 
6351. As soon as the P2A software is disconnected, the 
user menu is accessible again. 

 
Pos: 50 /TD/Produkt verwenden/MUF 63xx/Tastenblende @ 3\mod_1234454640248_79.doc @ 25232 @ 35  

4.4.2. Key cover 
To prevent unauthorized operation of the keys, the standard key 
frame can be replaced with a key cover. 
If the key cover has been assembled, the service flap must be 
opened for operation.  
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Attaching the key cover 
 

  

✓  The service flap is opened, see Opening the instrument, page 
19. 

1. Unscrew screws (3) and remove key frame (2). 
2. Insert key cover (1) into service flap and tighten screws (3). 
3. Close and screw down the service flap. 

Pos: 51 /TD/Produkt verwenden/MUF 63xx/Passwortschutz _635x @ 3\mod_1237383967006_79.doc @ 29969 @ 3 
 

4.4.3. Password protection 
The user menu can be protected with a four-digit numerical code 
(see Editing Main Menu Settings,  page 39) so that access to the 
user menu is denied to unauthorized persons not familiar with this 
numerical code. 
If the password protection is not to be used, the numerical code 
"0000" must be entered. This is also the status upon delivery. 

Pos: 52 /TD/Produkt verwenden/MUF 63xx/Aufbau des Bedienmenüs 635x @ 3\mod_1236162940119_79.doc @ 27333 @ 3  

4.4.4. Structure of user menu 
At the main menu level, the user menu comprises the following: 
• Main Menu Channel 1 
•  Main Menu Alarm 
• Main Menu Settings 



4 Transmitter 

  33 

• Main Menu Analysis 
• Main Menu Messages 
• Main Menu Ident 
• Main Menu Adjust 
• Main Menu Reset 

 

1 Channel 1 display 
2 No display 
3 Display for messages 

 

Four keys enable the user to navigate/scroll through the menus and 
enter/amend values and settings: 

 

Key  Function/description 
SET • In Measuring Mode: changes to 

parameterization 
• In Parameterizing Mode: confirms a 

selection or setting 
ESC • Leaves a menu (without modifying any 

settings) 
 • Selecting: scrolls through menus 

(downwards) or selectable alternatives 
• Editing: changes to next digit (to the right) 

 • Selecting: scrolls through menus (upwards) 
or selectable alternatives 

• Editing: increases the value of the current 
digit by 1 
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Pos: 53 /TD/Produkt verwenden/MUF 63xx/Übersicht Bedienmenü @ 3\mod_1234510821302_79.doc @ 25303 @ 3  

4.4.5. Overview of the testo 6351 user menu 
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Pos: 54 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Kanäle bearbeiten @ 3\mod_1234511119158_79.doc @ 25322 @ 34 
 

4.4.6. The individual main menus 
4.4.6.1. Editing main menu of channel 1 

An overview is given in Overview of the testo 6351 user menu, 
page 34). 
You can perform basic settings for channel 1. 
1. In the Measuring Mode press SET, select Main Menu 

Channel 1 with  or  and confirm selection with SET. 
One of the following parameters can now be selected using  
or , after which the selection must be confirmed with SET: 

• Channel 1 Unit 
The parameter for this channel is selected. 
Edit/select parameter with  or , confirm with SET or abort 
entry with ESC. 

• Scale minimum for channel 1: 
The lower scale limit is edited; Unit as selected above. 
Editing the value: Scroll one digit to the right using  and 
increase value of digit by 1 using . Confirm with SET or abort 
entry with ESC. 

• Scale maximum for channel 1 
The upper scale limit is edited; 
Unit as selected above. 
Editing the value: Scroll one digit to the right using  and 
increase value of digit by 1 using . Confirm with SET or abort 
entry with ESC. 

• Signal delay ("Attenuation") for channel 1 
The analog signal can be delayed ("Attenuation"); a time 
constant is selected for this (1 = no delay; 15 = longest delay) 
Edit/select parameter with  or , confirm with SET or abort 
entry with ESC. 

2. Continue to the main menu with  or  or return to Measuring 
Mode with ESC. 

Pos: 55 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Alarm bearbeiten 635x @ 4\mod_1245756301576_79.doc @ 45273 @ 455 
 

4.4.6.2. Editing Main Menu Alarm 
With the alarm, the relays, available as options, are programmed. 
In addition, the alarm statuses are shown on the display (top right) 
(even without relays).  
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You can choose whether the alarm is to be used to monitor limit 
values or as a collective alarm. If an alarm is to be used to monitor 
limit values, you can choose between monitoring the minimum or 
maximum value and set a limit value and hysteresis for each alarm. 
In addition, every alarm can be linked to a clearly visible visual 
alarm (display background lighting flashes). 
An alarm delay between 0 and 240 seconds can still be assigned to 
every alarm used for limit value monitoring so that both the 
corresponding relay effect and the visual alarm are delayed. If the 
alarm status goes out within the set alarm delay time, neither the 
visual alarm nor a relay connection is triggered. . 
With an alarm status present, the visual alarm and all relay outputs 
can be reset by means of acknowledgement. The triggering of a 
new alarm cannot be enabled until after the alarm status goes out.  
1. In the Measuring Mode press SET, select Main Menu Alarm 

with  or  and confirm selection with SET. 
- Four alarms can be parameterized. 
2. Select Alarm x with  or  and confirm selection with SET. 

Using alarm to monitor limit values 
 

NO contact 
Monitoring minimum Monitoring maximum 

Hysteresis  Hysteresis 

 
Limit value Limit value 

NC contact 
Monitoring minimum Monitoring maximum 

Hysteresis  Hysteresis 

 
Limit value Limit value  

3. Select Channel x (e.g. "Channel 1") with  or  and confirm 
selection with SET. 

4. Select Max control or Min control with  or  (see graphic). 
5. Press SET and edit Limit value as well as Hysteresis: Scroll 

one digit to the right using  and increase value of digit by 1 
using . Confirm with SET or abort entry with ESC. 
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6. Select Visual alarm with  or . Select YES or NO with  or 
. Confirm with SET or abort entry with ESC. 

7. Press SET and edit Alarm delay: Scroll one digit to the right 
using  and increase value of digit by 1 using  (0 to 240 
seconds possible). Confirm with SET or abort entry with ESC. 

8. Return to Channel x with ESC. 
9. Return to Alarm x with ESC. 
10. Change to the other relays using  or  and perform settings 

in the same way. 

Using alarm as collective alarm or not using it at all 
If an alarm is assigned to the collective alarm, the relay is switched 
and a visual alarm can be issued via the display as soon as (at 
least) one of the warning or error messages of the testo 6351 
transmitter becomes active. 

 

 
The messages affecting the collective alarm can only be 
selected in the P2A software, see Using the software, page 
56 

 

✓  Alarm is selected (see previous steps 1 and 2). 

1.  Use  or  to determine whether Alarm x should be used as a 
Collective alarm or not used. Confirm selection with SET. 

2. If collective alarm is selected: Select Visual alarm with  or . 
Select YES or NO with  or . Confirm with SET and return to 
Alarm x. 

3. Change to another alarm using  or  and perform settings in 
the same way. 

4. Return to Main Menu Alarm with ESC. 
5. Continue to Main Menu Settings with  or  or return to 

Measuring Mode with ESC. 
Pos: 56 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Einstellungen bearbeiten 635x @ 3\mod_1236608659829_79.doc @ 27573 @ 4555555 
 

4.4.6.3. Editing Main Menu Settings 
You can edit instrument settings and other settings. 
> In Measuring Mode, press SET, select Main Menu Settings 

using  or  and confirm selection with SET. 
You can edit settings for: 
• Display 
• Language 
• Code  
• Units  
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◦ Absolute pressure 
◦ Area 
◦ Temperature 
◦ Standard data 
◦ Process data 

Editing display settings 
You can set the brightness and contrast of the display. 
1. Select Display Settings with  or  and confirm selection with 

SET. 
2. Select Backlight or Contrast with  or  and confirm 

selection with SET. 
One of the following parameters can now be selected using  or 

, after which the selection must be confirmed with SET: 
• Backlight 

The display illumination is changed. 
Edit/select parameter with  or , confirm with SET or cancel 
entry with ESC (the effect of the change in parameter can be 
seen during input). 

• Contrast 
The brightness difference between the display background and 
the displayed values is changed. 
Edit/select parameter with  or , confirm with SET or cancel 
entry with ESC (the effect of the change in parameter can be 
seen during input). 

• Backlight 24h on 
Select On or Off using  or  and confirm with SET. 
Off: The display light switches off automatically if no button was 
pressed for 10 seconds. 
On: The display light is activated 

3. Return to Display Settings with ESC and use  or  to 
continue to Language. 
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Selecting language 
You can select the language for the plain text line in the display. 
> Press SET, select required language with  or , confirm 

selection with SET and return to Language. 
 

 
Only choose a language that you can understand well. 

 

Select unit  
This setting affects the unit of the standard and process data. 
1. Press SET, select Change parameters with  or , confirm 

selection with SET or cancel with ESC. 
2. Select Change unit with  or , confirm selection with SET or 

cancel with ESC. 
3. Select the required variable (absolute 

pressure/area/temperature) with  or , confirm selection with 
SET or cancel with ESC. 

4. Select the required unit with  or , confirm selection with SET 
or cancel with ESC. 

5 Return to Change unit with ESC and continue to Standard 
data with  or . 

Editing standard data  
Setting individual values for the standard data to calculate the 
volumetric flow rate. 
1.  Select Standard data with  or , confirm selection with SET 

or cancel with ESC. 
2. Select the required variable (absolute pressure/temperature) 

with  or , confirm selection with SET or cancel with ESC. 
3. Scroll one digit to the right using  and increase value of digit 

by 1 using . Confirm with SET or abort entry with ESC. 
4. Return to Standard data with ESC and use  or  to continue 

to Pressure process data. 

Editing pressure process data  
Setting of the process data for the Pitot tube calculation. 
1.  Select Pressure process data with  or  and confirm 

selection with SET. 
2. Select the required variable (absolute 

pressure/humidity/temperature/cross-section/Pitot tube 
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factor/correction factor) with  or , confirm selection with SET 
or cancel with ESC. 

3. Scroll one digit to the right using  and increase value of digit 
by 1 using . Confirm with SET or abort entry with ESC. 

4. Return to Pressure process data with ESC. 
5. Return to Change parameters with ESC and use  or  to 

continue to Code. 

Editing code settings 
You can set the access code (password). 

 

 
If a code other than "0000" (factory setting) is set, the 
transmitter can only be operated once this code has been 
entered via the menu. 

 

1. Select Code with  or  and confirm selection with SET. 
2. Scroll one digit to the right using  and increase value of digit 

by 1 using . Confirm with SET or abort entry with ESC. 
3. Return to Code with ESC. 
4. Return to Main Menu Settings with ESC. 

Pos: 57 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Analyse bearbeiten 635x @ 3\mod_1237277461094_79.doc @ 29753 @ 45555  

4.4.6.4. Editing Main Menu Analysis 
You can test the functionality of analog and relay outputs. In 
addition, you can read off the minimum and maximum values (since 
the last voltage supply or reset of the min./max. values). 

Testing functionality of analog outputs 
 

 
This function affects the analog outputs directly, not only 
the test contacts. 

 

1. In the Measuring Mode press SET, select Main Menu Analysis 
with  or  and confirm selection with SET. 

- Test Analog Output is shown. 
2.  Press SET, scroll one digit to the right using  and increase 

value of digit by 1 using . Any analog output value can be 
predefined, e.g. for an analog output of 4 to 20 mA, the value 
"6.0 mA". Confirm with SET or abort entry with ESC. 

3. Accept setting by pressing SET and test with multimeter 
(minimum requirement: resolution 6.5 digits, at least 2-times 
more accurate than the 6351) as follows: 
Analog output 1: Via test contacts under service flap, see 
diagram. 
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1 Channel 1 
test contacts 

2 Service 
interface 

3 Multimeter 

 

4. Return to Test Analog Output with ESC and use  or  to 
continue to Test Relay Output. 

Testing functionality of the pressure sensor (Test pressure 
sensor) 

 

 
This function is only required to calibrate the pressure 
sensor. 

 

Testing functionality of relay outputs 
1. Press SET and choose between Alarm 1, 2, 3, 4 with  or . 
2. Press SET. 

The relay can now be tested. You can choose between OFF 
and ON using  or . If ON is chosen, the NO contact is 
closed, the NC contact opened. If OFF is chosen, the NC 
contact is closed, the NO contact opened. 

3. To test, route a measuring cable from the relay terminals (see 
Connecting the relay outputs, page 23) out of the transmitter to 
a multimeter (resistance measurement) or continuity tester. 

4. Return to Test Relay Output with SET (starts relay test) or 
ESC (exits the menu without relay test). 

Reading off min./max. values of channels 
To reset the max./min. values, see Editing Reset main menu, page 
47  
1. Read off the min./max. values of the channel in succession with 

 or  and return to the Main Menu Analysis with ESC. 
2. Continue to Main Menu Message with  or  or return to 

Measuring Mode with ESC. 
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Pos: 58 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Meldungen bearbeiten @ 3\mod_1234526541417_79.doc @ 25398 @ 4 
 

4.4.6.5. Editing Message main menu 
Messages can be confirmed/acknowledged, the last messages can 
be called up and the display of the messages can be switched on 
or off. 

 

1 Operating hours at the 
time of message 

2 Message code (see 
Status, warning and error 
messages, page 47). 

3 Message text 
4 Message number 

(example: "4/7" refers to 
the fourth of seven 
messages) 

5 Number of messages 
present (example: "4/7" 
refers to the fourth of 
seven messages) 

 
 

 
Using the P2A software (see Parameterizing, adjusting and 
analyzing software (P2A software), page 53) you can 
predefine whether messages are to be shown in the 
display. 

 

1. In the Measuring Mode press SET, select Main Menu Message 
with  or  and confirm selection with SET. 

2. Confirm Confirm message using SET. 
3. Select Last messages with  or  and confirm with SET. 
4. Scroll between the warning and error messages recorded so far 

using  or  and return to Last messages using ESC. 
5. Select Information with  or  and confirm with SET. 
6. Scroll between the status messages recorded so far using  or 

 and return to Information using ESC. 
7. Continue to Display of message with  or . 

ON: Measurements are shown on the display in Measuring 
Mode. 
OFF: No messages shown on display. 

8. Select ON or OFF with  or  and confirm selection with SET. 
9. Return to Main Menu Message with ESC. 
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10. Continue to Main Menu Ident with  or  or return to 
Measuring Mode with ESC. 

 

 
An overview of the messages can be found in Status, 
warning and error messages, page 47 

 
Pos: 59 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Ident abfragen 635x @ 3\mod_1238158282021_79.doc @ 30233 @ 4 
 

4.4.6.6. Calling up Main Menu Ident 
 

1 Instrument type 
2 Build number  
3 Firmware 

version 
4 Serial number 

 

1. In the Measuring Mode press SET, select Main Menu Ident 
with  or  and confirm selection with SET. 

- The type, firmware version, build number and serial number of 
the transmitter are displayed. 

 

 
This information is required when servicing. 

 

2. Return to Main Menu Ident with ESC. 
3. Continue to Main Menu Adjust with  or  or return to 

Measuring Mode with ESC. 
Pos: 60 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Abgleich bearbeiten 635x @ 3\mod_1236081643663_79.doc @ 27232 @ 455 
 

4.4.6.7. Editing Main Menu Adjust 
Also see Analog output adjustment, page 29, for instructions on 
how to perform the analog adjustment.  

 
 

Performing analog adjustment 
1. In the Measuring Mode press SET, select main menu Adjust 

with  or  and confirm selection with SET. 
 

 
Each channel is adjusted at three points in the analog 
range (at 10 %; 50 %; 90°% of the analog scale). 

 

2. Select Analog Adj. Ch. 1 with  or  and confirm with SET. 
3. Use  or  to select Adj. Point 1. 
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4. Press SET. Read off multimeter display and enter this value in 
the user menu. Do this by scrolling one digit to the right using  
and increasing the value of digit by 1 using . Confirm with 
SET or abort entry with ESC. 

5. Use  or  to select Adj. Point 2. 
6. Press SET. Read off multimeter display and enter this value in 

the user menu. Do this by scrolling one digit to the right using  
and increasing the value of digit by 1 using . Confirm with 
SET or abort entry with ESC. 

7. Use  or  to select Adj. Point 3. 
8. Press SET. Read off multimeter display and enter this value in 

the user menu. Do this by scrolling one digit to the right using  
and increasing the value of digit by 1 using . Confirm with 
SET or abort entry with ESC. 

9.  Return to main menu Adjust with ESC. 
10. Continue to main menu Reset with  or  or return to 

Measuring Mode with ESC. 

Performing the pressure adjustment 
Also see n-point adjustment, page 30, for instructions on how to 
perform the pressure adjustment.  
1. In the Measuring Mode press SET, select main menu Adjust 

with  or  and confirm selection with SET. 
 

 
The pressure adjustment can be performed at 3 to 6 
adjustment points.  

 

2. Select Adjust Pressure with  or  and confirm with SET. 
3. Use  or  to select Adj. Point 1. 
4. Press SET. Read off pressure sensor display and enter this 

value in the user menu. Do this by scrolling one digit to the right 
using  and increasing the value of digit by 1 using . Confirm 
with SET or abort entry with ESC. 

5. Repeat steps 1 to 4 for adjustment points 2 to 6. 
6.  Return to main menu Adjust with ESC. 
7. Continue to main menu Reset with  or  or return to 

Measuring Mode with ESC. 
Pos: 61 /TD/Produkt verwenden/MUF 63xx/Hauptmenü Reset bearbeiten 635x @ 3\mod_1238480830340_79.doc @ 30373 @ 4 
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4.4.6.8. Editing Reset main menu 
You can reset the factory settings for the following: 
• Instrument 
•  Min./max. values 

 

 
Resetting to the factory settings means resetting to the 
order specification, i.e. the specific condition at the time of 
supply to the customer. 

 

1. In the Measuring Mode press SET, select Main Menu Reset 
with  or  and confirm selection with SET. 

- Reset Device to factory settings is displayed. 
2. Select the setting to be reset using  or  and confirm 

selection with SET. 
- Reset Completed is displayed. 
3. Return to the reset setting with ESC or SET and return to Main 

Menu Reset with ESC. 
4. Continue to the Main Menu Channel 1 with  or  or return to 

Measuring Mode with ESC. 
Pos: 62 /TD/Überschriften/MUF/1.5 Status-, Warn- und Fehlermeldungen @ 3\mod_1234442925442_79.doc @ 24963 @ 2  

4.5. Status, warning and error messages 
Pos: 63 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Status-, Warn- und Fehlermeldungen 635x @ 3\mod_1237458634551_79.doc @ 30125 @  
 

To achieve optimum operational reliability (machine availability), 
the transmitter shows the following via the user menu or the P2A 
software 
• Status messages 
• Warning messages 
• Error messages 
in each case for the testo 6351 transmitter. 
All messages are stored in the transmitter with an operating hours 
stamp. Use the user menu (see Editing Message main menu, page 
44) or the P2A software (see Transmitter history, page 75) to view 
the message history. 
In the transmitter, the last 60 status messages and the last 120 
error and warning messages are stored in a ring memory. There is 
no limit in the P2A software. 

Pos: 64 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Statusmeldungen 635x @ 3\mod_1235651943832_79.doc @ 26823 @ 3 
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4.5.1. Status messages 
Status messages show the current operating status of the testo 
6351. 

 

Message Display Description 
02506 Sensor 

initialization 
Message appears while the 
transmitter is starting up. If the 
message disappears, the 
transmitter is ready for operation. 

01D19 Service plug The Mini-DIN socket is connected 
to: the USB adapter for P2A 
software, the adjustment adapter 
or the service plug (is not 
recorded/no number) 

00300 New limit value The limit value has been changed 
or shifted 

00301 Scaling changed The scaling has been changed 
00117 Adjustment DeltaP An n-point adjustment was 

performed. 
02104 Analog adjustment An analog adjustment has been 

made 
00530 Change solenoid 

valve 
The solenoid valve should be 
changed 

00500 Transmitter reset The transmitter was reset to the 
factory settings and is restarted. 

0052F Reset Min/Max Resets all saved Min/Max values 
for all channels 

00503 Reset device to 
fact 

A factory reset of the transmitter 
was performed 

00307 User Setting 
Change 

User Setting Change: General 
settings were changed for the 
transmitter. 

 
Pos: 65 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Warnmeldungen 635x @ 3\mod_1236081573428_79.doc @ 27192 @ 3 
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4.5.2. Warning messages 
Warning messages show an early warning or a current malfunction 
which may negatively impact measuring. 

 

Message  Display Cause Remedying of fault 
00E00 T ambient high The ambient 

temperature exceeds 
the permissible 
temperature for the 
transmitter 

Take necessary 
measures to lower 
ambient temperature, 
e.g. through venting or 
cooling 

00E01 T ambient low The ambient 
temperature is below 
the permissible 
temperature for the 
transmitter 

Take necessary 
measures to raise 
ambient temperature, 
e.g. through heating 

00809 Pressure too 
high 

The process pressure 
exceeds the pressure 
intended for the 
transmitter 

Remove the transmitter 
from the process and 
take any necessary 
measures to lower the 
pressure 

00E02/00E
05 

Supply voltage 
low 

The supply voltage is 
below the minimum 
voltage required for the 
transmitter 

Take measures to 
ensure sufficient 
voltage supply 

0081C Alarm 1 Depending on the 
parameterization of the 
relay 

Depending on the 
parameterization of the 
relay 

0081D Alarm 2 Depending on the 
parameterization of the 
relay 

Depending on the 
parameterization of the 
relay 

0081E Alarm 3 Depending on the 
parameterization of the 
relay 

Depending on the 
parameterization of the 
relay 

0081F Alarm 4 Depending on the 
parameterization of the 
relay 

Depending on the 
parameterization of the 
relay 

 
Pos: 66 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Fehlermeldungen Messumformer 635x/6781 @ 3\mod_1236081613819_79.doc @ 27212 @ 3 
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4.5.3. Transmitter error messages 
Error messages show a current malfunction. 

 

Message  Display Cause Remedying of fault 
01505 Watchdog error Due to a processor 

error, the transmitter 
performs an automatic 
restart. 

If the problem occurs 
frequently, contact 
Testo Service. 

01115 Low adjustment 
temperature 

The ambient 
temperature is too low 
during the pressure 
adjustment. 

Take necessary 
measures to raise 
ambient temperature, 
e.g. through heating.  

01116 High adjustment 
temperature 

The ambient 
temperature is too high 
during the pressure 
adjustment. 

Take necessary 
measures to lower 
ambient temperature, 
e.g. through venting. 

 
Pos: 67 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Behandlung von Alarmmeldungen 635x @ 3\mod_1236081852932_79.doc @ 27252 @ 3 
 

4.5.4. Handling alarm messages 
 

Shown on the 
display5  

Can be used for 
collective alarm6 

Additional 
message end7 

New limit value x  
Scaling changed x  
Adjustment DeltaP x  
Pressure too high x x 
Alarm 1  x 
Alarm 2  x 

                                                           
5 If multiple messages/alarms are activated at the same time, only the last 
message/alarm is shown. If this is cancelled, the other messages that are still 
active are no longer displayed. 
6 The message can be assigned the collective alarm function, which means that 
the collective alarm is activated as soon as at least one of the messages 
assigned to it is activated. The collective alarm can be assigned to each of the 4 
optional relays. The collective alarm is then always the same, as it can only be 
defined once. 
7 The message is shown upon the occurrence of the event causing the message 
as well as when closing. Two entries appear in the history in the P2A software: 
Message text_start and Message text_end. 
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Shown on the 
display5  

Can be used for 
collective alarm6 

Additional 
message end7 

Alarm 3  x 
Alarm 4  x 
Transmitter reset x  
Analog adjustment x  
T ambient high x x 
T ambient low x x 
Supply voltage low x x 
Watchdog error x  

 

Perform the Confirm message function (acknowledgement of the 
alarm via the control keys on the transmitter): 
• The message/alarm is no longer shown on the display and the 

optical alarm goes out, where applicable. If multiple 
messages/alarms are active at the same time, all are reset 
simultaneously. 

• If at least one message is assigned to the collective alarm, the 
collective alarm is reset. If the collective alarm is set on a relay, 
the relay is also reset, meaning switched to its neutral position. 

Pos: 68 /TD/Produkt verwenden/MUF 63xx/Status-Warnmeldungen/Namur Fehlerbedingungen 635x @ 3\mod_1236939722916_79.doc @ 29433 @ 3 
 

4.5.5. Namur fault conditions 
If the faults named in the following table occur, the analog outputs 
output special values that enable a general fault warning in the 
higher-level control system. The values correspond to the "Namur" 
industry standard. 

 

Status 
message in 
the display  

Class Display 
value in the 
display 

Analog output 

 0 to 
20 mA 

4 to 
20 mA 

1 V 5 V 10 V

Watchdog 
error 

Error Previous 
value stops 

21 mA 3.8 mA 1.1 V 5.5 V 11 V

Value below 
min. scale 

Underrange Reading  0 mA 3.8 mA 0 V 0 V 0 V 

Value above 
max. scale  

Overrange  Reading  20.5 mA 20.5 mA 1.1 V 5.5 V 11 V
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Status 
message in 
the display  

Class Display 
value in the 
display 

Analog output 

Pressure too 
high 

Overrange ooooo · 20.5 mA 20.5 mA 1.1 V 5.5 V 11 V 

 
Pos: 69 /TD/Überschriften/MUF/1.6 Wartung und Reinigung @ 3\mod_1234443039129_79.doc @ 24982 @ 2 
 

4.6. Maintenance and cleaning 
Pos: 70 /TD/Produkt instand halten/MUF 63xx/Gerät warten/reinigen 635x @ 4\mod_1245756987352_79.doc @ 45305 @ 33 
 

4.6.1. Maintaining the instrument 
We recommend that the adjustment and settings of the transmitter 
be checked at regular intervals using the 
• User menu (Operation, page 31) or 
• P2A software (Parameterizing, adjusting and analyzing software 

(P2A software), page 53) 
Convenient "remote monitoring" of the transmitter can be 
implemented, for example by using a relay as a collective alarm 
(see Editing Main Menu Alarm, page 37) whose messages are 
forwarded to a local alarm transmitter (horn, light) or PLC. 

4.6.2. Cleaning the instrument 
• Only clean the instrument carefully with a moist cloth. 
• Do not use aggressive cleaning agents. 
• Do not use any solvents. 

Pos: 71 /TD/Überschriften/MUF/3 Parametrier-, Abgleich und Analysesoftware (P2A-Software) @ 3\mod_1234258523713_79.doc @ 23932 @ 1 
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5 Parameterizing, adjusting and analyzing 
software (P2A software) 

Pos: 72 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

5.1. Specifications 
Pos: 73 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 63xx P2A @ 3\mod_1234258967326_79.doc @ 24065 @ 355 
 

The P2A software is used for the parameterizing, adjustment and 
analysis of testo transmitters. The following applies: 
• Generally, all newer testo transmitters (as of 2007) are 

supported. 
• Included with every testo transmitter that is bought new is a CD 

that contains a free upgrade of the software, which includes the 
device drivers for all transmitters that can be attached at this 
time. 

• This upgrade can be downloaded at any time via the testo 
homepage "www.testo.com/Download/P2A". 

The software must only be bought one time, even for owners of 
several testo transmitters. 

5.1.1. Functions and use 
In the P2A software, two different file types are used: The 
instrument and the parameter file. 

Instrument file 
The parameters of a particular transmitter are stored in its so-called 
instrument file. Using this file, the parameters can be edited and the 
instrument can be tested and adjusted. 
Instrument files also contain the respective histories in addition to 
the parameter data, i.e. "log books" are kept for the previous 
parameterizations, adjustments and messages (see Transmitter 
history page 75). 

 

 
Instrument files are ".cfm" format files. 

 

Parameter file 
Parameter files are not tied to a specific individual transmitter and 
contain only parameter data/no history data. 
If you use various instruments of the same type, you can create 
parameter files once (e.g. by saving the appropriate instrument file 
as the parameter file) and transmit these onto the other 
instruments. 
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Parameter files are ".cfp" format files. 

 Pos: 74 /TD/Leistungsbeschreibung/Systemvoraussetzungen/MUF 63xx @ 3\mod_1234260654399_79.doc @ 24084 @ 3555 
 

5.1.2. System requirements 
Operating system 
• Windows® 2000 SP4 
• Windows® XP Home/Professional 
• Windows® Vista 

Computer 
• Pentium processor of at least 400 MHz or equivalent 
• 128 MB RAM 
• Graphics resolution of at least 1024 x 768  
• Unused hard drive capacity of at least 15 MB 
• CD-ROM drive 
• USB interface 
• At least Internet Explorer 5.0. 

Software 
The P2A software must be purchased and installed separately from 
the transmitter. If it is a new software version, the transmitter is 
already supported completely. Older P2A software versions can be 
updated via the P2A software upgrade (cf. product CD included 
with the transmitter). 

Pos: 75 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 63xx P2A @ 3\mod_1234260991646_79.doc @ 24103 @ 3 
 

5.1.3. Scope of delivery 
Included in the scope of delivery are: 
• P2A software 
• USB driver 

 

 
When working with the parameterizing, adjusting and 
analyzing software (P2A software), previous knowledge of 
Windows® operating systems is assumed. The description 
in this instruction manual relates to Windows® XP. 
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Pos: 76 /TD/Überschriften/MUF/3.2 Erste Schritte @ 3\mod_1234258633304_79.doc @ 23970 @ 2  

5.2. First steps 
Pos: 77 /TD/Erste Schritte/MUF 63xx/P2A/Software/Treiber installieren @ 3\mod_1234261192065_79.doc @ 24123 @ 3444 
 

5.2.1. Installing the software/driver 
 

 
Administrator rights are required to install programs and 
drivers under Windows® 2000 SP4, XP and Vista. 

 

5.2.1.1. Installing P2A software 
1. Insert CD with P2A software.  

✓  If the installation program does not start automatically: 

> Open Windows Explorer and start the file Setup.exe on the 
product CD. 

2. Follow the directions of the installation wizard. 

5.2.1.2. Installing USB driver 
 

 
Before installing the USB driver, please read the separate 
documentation that is enclosed with the USB driver CD. 

 

5.2.1.3. P2A software upgrade 
1. Insert product CD (supplied with the transmitter). 
2. Open Windows® Explorer and start the file P2A upgrade.exe 

on the product CD. 
3. Follow the directions of the installation wizard. 

Pos: 78 /TD/Erste Schritte/MUF 63xx/P2A/Software starten @ 3\mod_1234261605199_79.doc @ 24142 @ 3444 
 

5.2.2. Starting the software 
5.2.2.1. Starting the program 

> Select: [Start] > All Programs > Testo > P2A Software. 
- The program window is opened (see User interface page 56). 

5.2.2.2. Establishing a connection with the instrument 
Multiple instruments can be attached, however only one connection 
is active at all times. 

✓  USB driver is installed (see Installing USB driver page 55). 

1. Start the P2A software. 
2. Connect adapter (supplied with the P2A software) to the service 

interface of the instrument (see Service interface page 15). 
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3. Connect instrument/adapter to the PC via the USB interface. 
- The instrument file of the attached instrument is shown in the 

file list. 

5.2.2.3. Activating the connection with the instrument 
> Click on the desired instrument file. 
- The selected file is marked in colour and the connection with 

the instrument is activated. 
If a connection with the instrument is established when the program 
is started, the corresponding instrument file is marked 
automatically. 

Pos: 79 /TD/Überschriften/MUF/3.3 Software verwenden @ 3\mod_1234258679599_79.doc @ 23989 @ 2 
 

5.3. Using the software 
Pos: 80 /TD/Produkt verwenden/MUF 63xx/P2A/Software verwenden @ 3\mod_1234262654547_79.doc @ 24162 @ 3 
 

5.3.1. User interface 
 

  

1 Menu bar: 
 

Menu  Command  Explanation 
File Open Shows the Windows dialogue for 

searching and opening files. 
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Menu  Command  Explanation 
 Save as Saves the parameters of an 

instrument or parameter file 
under a new name. 

Edit Copy Copies the parameters of the 
marked instrument or parameter 
file in the cache. 

 Paste Pastes the parameters from the 
cache in the marked instrument 
or parameter file. 

View Toolbar 
Status bar 

Activates/deactivates the toolbar 
or status bar. 

? Check instrument 
connections 

Checks the connections to a 
connected instrument without the 
instrument having to be 
activated. 

 Service A text file with the most important 
information on the computer and 
the software is opened via 
Display service data. 

 Information Shows the version number of the 
P2A software. 

  
 

2 Toolbar: Shows the Windows-compliant icons for editing. 
3 File: 

 

Icon  File Explanation 

 
Symbol shows a 
transmitter 

Instrument 
file 

Instrument file 
Connection to the instrument has 
been established. 
<Type> <Serial number>.cfm 
File name should not be 
changed. 

 
Symbol shows a 
transmitter with a red 
minus sign in the upper 
left corner 

Instrument 
file 

Instrument file 
Connection to the instrument has 
not been established. 
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Icon  File Explanation 

 
Symbol shows a 
transmitter with a white 
P for parameter file in 
the upper left corner 

Parameter 
file 

<Type> <Serial number> 
<Date> <Time>.cfp 
File name can be changed. 
The name can be selected freely, 
but it is recommended that you 
retain the reference to the 
instrument. 
Parameter files are always 
marked red; the parameter 
values they contain are only 
forwarded to the instrument after 
being transmitted to the 
instrument file. 

 

4 Function buttons: Dialogues on editing and testing the 
instrument are opened by means of the buttons. 

[Change parameterization] see Changing instrument/parameter 
file page 59  
[Test/analyze transmitter] see Chapter Analyzing/testing the 
transmitter page 68 
[Adjusting the transmitter] see Chapter Adjusting the transmitter 
page 73  
[Transmitter history] see Transmitter history page 75  
5 File information: 

 

Status  Shown in the window  
An instrument file is 
selected 

Type, serial number, firmware version of the 
instrument. 

A parameter file is 
selected 

Type, serial number and firmware version of 
instrument for which the parameter file was 
created. 

Connection status Green = connection is active 
Red = connection is inactive 

 

6 Status bar: Shows the current status when editing via the menu 
bar. 



5 Parameterizing, adjusting and analyzing software (P2A software) 

  59 

Pos: 81 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei bearbeiten @ 3\mod_1234358080444_79.doc @ 24303 @ 34 
 

5.3.2. Editing instrument/parameter file 
5.3.2.1. Changing instrument/parameter file 

✓  The desired instrument/parameter file is marked. 

1. Click on [Change parameterization]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Change parameterization register. 
If the parameters were transmitted from other parameter files into 
the instrument file, a message is shown with which you can 
transmit the new parameters to the connected instrument using 
[Yes]. 

> If the parameters should not be transmitted, click on [No]. 
2. Change or enter parameters in the corresponding fields. 

Pos: 82 /TD/Produkt verwenden/MUF 63xx/P2A/Einheit / Analogausgang @ 3\mod_1234366217517_79.doc @ 24592 @  
 

Field Explanation 
Unit/ 
Analog output 

All analog outputs are parameterized in this 
mask. 



5 Parameterizing, adjusting and analyzing software (P2A software) 

60 

Field Explanation 
Unit/analog output 
(graphic) 

Unit: 0 to 1 V/5 V/10 V or 0 to 20 mA/4 to 
20 mA. 
Vertical: Current version of the analog output 
(cannot be changed). 
Horizontal: Min./max. scale end points of 
selected unit. 
The curve changes in accordance with the 
entered value of scale minimum and 
maximum. 

Scale minimum/ 
maximum 

The endpoints of the scaling can be selected 
up to the stored scale minimum and 
maximum. In the process, scaling can take 
place beyond the measuring range in order 
to adjust the analog output to the customer 
system, see Scaling, page 16 

Unit Selection of the physical unit. 
When changing the unit, standard values are 
set for scale minimum and maximum. 
Caution! 
When changing the phys. unit, the relay limit 
values are set to the assigned default values. 

Signal delay 
(graphic) 

Curve changes according to the set signal 
delay. 

Signal delay Time interval in stages 1 – 15: 
1 = no delay 
15 = longest delay. 
The signal delay is added to the reaction time 
of the sensor. The signal delay shows 
averaging over the time interval of the 
selected stage in seconds: 
Example 
Stage 10 = average of the readings from the 
last 10 seconds. 

 
 
 Pos: 83 /TD/Produkt verwenden/MUF 63xx/P2A/Grenzwerte Relais  @ 3\mod_1234366741293_79.doc @ 24611 @  
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Field  Explanation 
Limit values, relay 1 to 4/alarm 
values, alarm 1 to 4 

In this mask, the relays or display 
alarms are parameterized. 

Relay x/alarm x Four relays or alarm values are 
available (optional). 

Not used Relay is not used. 
Hysteresis image and input 
options are hidden. 

Collective alarm A relay can be used as a collective 
alarm detector in the event that 
selected messages appear. 
Selection of the messages (OR 
linkage) by selecting the 
checkbox. 

Min control If switched to ON (NO contact) or 
OFF (NC contact) under the limit 
value; in the event of a 
subsequent exceeding of Limit 
value plus Hysteresis, it is 
switched to OFF (NO contact) or 
ON (NC contact). 
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Field  Explanation 
Max control If switched to ON (NO contact) or 

OFF (NC contact) above the limit 
value; in the event of a 
subsequent undershooting of 
Limit value minus Hysteresis, it 
is switched to OFF (NO contact) or 
ON (NC contact). 

 
  

 
The graphic display in the centre of the screen refers to 
the relay wiring as a NO contact (ON). 

  

Hysteresis To avoid switching cycles. 
Channel Selection of the channel that is to 

be monitored. 
Limit value Values for the limits of the unit 

selected in Unit/analog output; 4 
decimal places. 
When changing the phys. unit, the 
relay limit values are set to the 
default values. 

Visual alarm display Checkbox is activated: Upon the 
appearance of the selected alarm, 
the background lighting of the 
display flashes. 
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Field  Explanation 
Alarm delay The desired alarm delay for the 

alarms of the min/max control and 
the visual alarm is entered in the 
input field (0 to 240 seconds 
possible).  
The alarm delay has no effect on 
the collective alarms. 

 Pos: 84 /TD/Produkt verwenden/MUF 63xx/P2A/Prozessdaten Druck+Normdaten 635x/6381 @ 3\mod_1235994444633_79.doc @ 26986 @  
 

Field  Explanation 
Basic settings Setting the pressure process data for Pitot 

tube measurement and standard data for 
volumetric flow rate measurement. 

Absolute pressure Absolute pressure existing in the process. 
The entered absolute pressure value is 
included in the Pitot tube calculation. 

Temperature Temperature existing in the process. The 
entered temperature value is included in the 
Pitot tube calculation. 

Humidity Humidity existing in the process. The entered 
humidity value is included in the Pitot tube 
calculation. 
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Field  Explanation 
Pitot tube factor The Pitot tube correction factor depends on 

the shape of the Pitot tube (see operating 
instructions of the Pitot tube).  
The entered correction factor has a direct 
proportional effect on the volumetric flow 
rate. 

Cross-section of the 
duct 

The entered value is included in the Pitot 
tube calculation. 

Correction factor The correction factor enables an adjustment 
to the flow profile in the duct. 
The entered correction factor is included in 
the Pitot tube calculation. 

 
Absolute pressure The entered value and the selected unit are 

included in the calculation of the standard 
volumetric flow rate. 

Temperature The entered value and the selected unit are 
included in the calculation of the standard 
volumetric flow rate. 

[Reset] Button for resetting the standard data to the 
factory settings. 
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Pos: 85 /TD/Produkt verwenden/MUF 63xx/P2A/Display @ 3\mod_1234424330866_79.doc @ 24673 @  
 

Field  Explanation 
Display Setting the display functions (if a display is 

available on the transmitter). 

Continuous display 
lighting 

Display lighting is permanently switched on. 

Display lighting 
when button is 
pressed 
(10 seconds) 

When a particular button on the instrument is 
pressed, the display lights up for 10 seconds.

Display brightness 
(0 to 9) 

Setting the brightness between 0 and 9: 
0 = dark 
9 = light 

Display contrast 
(0 to 9) 

Setting the contrast between 0 and 9: 
0 = low contrast 
9 = high contrast 

Display of the error 
messages 

Selection of whether the error messages 
should be shown in the display. 

Display language Selection of the language. 
New password The password consists of four numbers, 

each of which must be between 1 and 9.  
If the password protection is not to be used, 
the numerical code "0000" must be entered. 
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Field  Explanation 
[Adopt new 
password] 

Button for confirming the new password. 

Valid password Display of the current password. 
 
Pos: 86 /TD/Produkt verwenden/MUF 63xx/P2A/Nullungszyklus @ 3\mod_1235995952936_79.doc @ 27005 @   

Field  Explanation 
Zeroing cycle Setting the interval of the automatic zeroing 

with solenoid valve. 

 
  

 
The accuracy specifications are only valid for the zeroing 
cycle of 15 sec set by the factory.  

  

Zeroing cycle setting Selection of the time interval after which the 
automatic zeroing cycle is to occur. 
Recommendation: 15 sec 

 
Pos: 87 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter speichern @ 3\mod_1234358425697_79.doc @ 24322 @ 4  

5.3.2.2. Saving parameters 
Parameters can be saved in new parameter files. 
1. Mark instrument/parameter file. 
2. Click on File > Save as in the menu bar. 
3. Select storage location and enter the file name. 
4. Click on [Save]. 
- The new parameter file is shown in the file list. 
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Only the parameters are saved from an instrument file; the history 
data are not adopted. 

 

 
The original name (Instrument type, Serial number) is 
suggested with the current date/time as standard, e.g. 
"testo 6351 01234578 061120 1403.cfp". 
For a standard installation, the files are saved under 
"C:\Documents and Settings\All Users\Shared 
Documents\P2A Software". The path can differ depending 
on the version of the operating system. 

 
Pos: 88 /TD/Produkt verwenden/MUF 63xx/P2A/Parameterdatei öffnen @ 3\mod_1234358634164_79.doc @ 24341 @ 4 
 

5.3.2.3. Opening the parameter file 
All parameter files stored in the standard directory path are 
automatically displayed in the file list when the software is started. 
You can also open parameter files that are stored in other 
directories. 
1.  Click on File > Open in the menu bar. 
2. Select the storage location and click on the requisite file. 
3. Click on [Open]. 
- The selected file is opened. This can be changed and saved 

(see Editing instrument/parameter file page 59). 
Pos: 89 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter kopieren/einfügen @ 3\mod_1234358826054_79.doc @ 24360 @ 4 
 

5.3.2.4. Copying and pasting parameters 
The parameters of a parameter file can be transmitted to an 
instrument file or another parameter file from the same instrument 
type. 
1. Select file from which parameters are to be copied. 
2. Click on Edit > Copy in the menu bar. 
3. Select the file which is to be modified. 
4. Click on Edit > Paste in the menu bar. 
- The parameters are transmitted to the file. 

 

 
You can also use the common keyboard shortcuts for 
copying (CTRL+C) and pasting (CTRL+V). 
Parameters can also be transmitted using drag & drop, 
where you drag the icon of the parameter file onto the icon 
of the target instrument file. 

 

5. Connect and select corresponding instrument. 
6. Click on [Change parameterization]. 
7. Confirm confirmation request. 
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- Parameter data are transferred to the instrument. 
  
Pos: 90 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei löschen @ 3\mod_1234359025194_79.doc @ 24379 @ 4 
 

5.3.2.5. Deleting instrument/parameter file 
Instrument/parameter files can be deleted from the file list. 
1. Click on the file that is to be deleted with the right mouse button. 
2. Select the command Delete in the context menu. 
- The instrument or parameter file is deleted from the list. 

Pos: 91 /TD/Produkt verwenden/MUF 63xx/P2A/Gerätedatei erzeugen @ 3\mod_1237206865717_79.doc @ 29703 @ 4 
 

5.3.2.6. Creating a new instrument file 
It is possible to create an instrument file without restarting the P2A 
software. 

✓  Transmitter must be connected. 

1. Click on File > New connection in the menu bar. 
- Connection to the transmitter is established. 

Pos: 92 /TD/Überschriften/MUF/x.x.x Messumformer analysieren / testen @ 3\mod_1237380874787_79.doc @ 29928 @ 3 
 

5.3.3. Analyzing/testing the transmitter 
Pos: 93 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer analysieren/testen 635x @ 3\mod_1234359444253_79.doc @ 24398 @ 4 
 

In this section, you can test the outputs of the connected 
instrument, read off the limit values and reset the parameters to the 
factory settings. 
The function is only available for instrument files. 

5.3.3.1. Analyzing/testing the instrument 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Perform action: 

 

Action  Explanation 
Carrying out factory 
reset 

Reset the unit, limit value and hysteresis 
parameters to factory settings (see below). 

Testing analog 
output 

Test channel 1 (see Testing functionality of 
analog outputs, page 42). 

Test switch outputs Manually switch relays 1 to 4 to test for 
proper function (see Testing functionality of 
relay outputs, page 43). 
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Action  Explanation 
Display min./max. 
values 

Overview of the minimum and maximum 
values measured since the last reset of the 
transmitter (see Displaying min./max. values, 
page 72). 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 94 /TD/Produkt verwenden/MUF 63xx/P2A/Werksreset durchführen @ 3\mod_1237379864072_79.doc @ 29887 @ 4 
 

5.3.3.2. Carrying out factory reset 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark transmitter test. 
- Current operating hours are shown. 
3. Confirm control query to perform the reset. 
- The values are reset to the customer-specific factory settings. 
4. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 95 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang testen 635x @ 3\mod_1237382683201_79.doc @ 29948 @ 4 
 

5.3.3.3. Testing analog output 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark channel and test values. 

 

Field/button Explanation 
Transmitter test Check the analog outputs (see Testing 

functionality of analog outputs, page 
42). 
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Field/button Explanation 

 
Current reading Readings are updated every second. 
Unit Unit according to the type of analog 

output. 
Default value Freely definable output value for the 

respective type of analog output (V or 
mA), 1 decimal place. 

[Activate] The entered default value is forwarded 
to the corresponding analog output 
and to the test contacts by clicking. 
A warning informs that the value is 
being transmitted to the connected 
instrument in the event of existing 
cabling. 
Now check the analog output using a 
precise multimeter. 

[Deactivate] Finish entering the electrical variables 
at the analog output. 
The analog output returns to the 
current reading again. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output and the relay return to Measuring Mode 

again. 
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Pos: 96 /TD/Produkt verwenden/MUF 63xx/P2A/Schaltausgang Relais testen 635x @ 3\mod_1237374457598_79.doc @ 29866 @ 4 
 

5.3.3.4. Testing switch output relays 1 to 4 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Relay tests and test the values. 

 

Field/button  Explanation 
 Test the relay function (see Testing 

functionality of relay outputs, page 43). 

[Activate relay n] Close contact. 
A warning informs that the value is being 
transmitted to a connected PLC, external 
display, etc. in the event of existing cabling. 

[Deactivate relay 
n] 

Open contact. 
A warning informs that the value is being 
transmitted to a connected PLC, external 
display, etc. in the event of existing cabling. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output returns to Measuring Mode again. 
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Pos: 97 /TD/Produkt verwenden/MUF 63xx/P2A/Min-/Max-Werte anzeigen 635x @ 3\mod_1242135985269_79.doc @ 32803 @ 4 
 

5.3.3.5. Displaying min./max. values 
The transmitter saves the minimum or maximum value for each 
channel (measured since the last voltage supply or since the last 
manual reset). 

✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Min./max. values. 

 

Field/button  Explanation 
Min./max. values View the min./max. values of each channel. 

Only the values within the measuring range 
are shown. 

 
Channel Channel 1 min./max. 
Value Min. or max. value, 1 decimal place. 
Unit Unit selected in Unit/analog output. 

 

3. Reset Min./max. values. 
4. Click on [Reset min./max. values]. 
5. Confirm control query to perform the reset. 
- The values are reset to the factory settings. 
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6. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 98 /TD/Überschriften/MUF/x.x.x Messumformer abgleichen @ 4\mod_1244530152797_79.doc @ 44885 @ 3  

5.3.4. Adjusting the transmitter 
Pos: 99 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer abgleichen 635x @ 3\mod_1235996515230_79.doc @ 27024 @  
 

This function is used to adjust an attached instrument. The 
following adjustments may be carried out using the software: 
•  Analog adjustment (entry via assistant/wizard) 
• n-point adjustment (entry via assistant/wizard) 
Also see Editing Main Menu Adjust, page 45  

Pos: 100 /TD/Produkt verwenden/MUF 63xx/P2A/n-Punkt-Abgleich _635x @ 3\mod_1237457345714_79.doc @ 30083 @ 4  

5.3.4.1. n-point adjustment 
1. Connect precision pressure sensor (see n-point adjustment, 

page 30). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Mark n-point adjustment. 
5. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 

 

Field Explanation 
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Field Explanation 
How much pressure 
is actually applied 

Required field: Entry of the value read off at 
the pressure sensor. 

 

 
The n-point adjustment must always be carried out to its full 
extent and in good time at all selected adjustment points.  

 
 

 
The number of adjustment points (3 to 6) is stored in the 
user menu of the transmitter and can only be changed via 
the P2A software. 

  
Pos: 101 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang abgleichen _635x @ 3\mod_1234363369967_79.doc @ 24531 @ 4 
 

5.3.4.2. Adjusting the analog output 
1. Connect precision multimeter (see Analog output adjustment, 

page 29). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 

 

Field Explanation 
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Field Explanation 
Default value The analog output value from the last 

performed adjustment is given at the output. 
Value of the factory adjustment: 
• Lower adjustment point: approx. 10 % of 

the max. value 
• Centre adjustment point: approx. 50 % of 

the max. value 
• Upper adjustment point: approx. 90 % of 

the max. value 
Measured analog 
value 

Required field: Entry of the value read off at 
the multimeter. 

 
Pos: 102 /TD/Überschriften/MUF/2.3.5 Messumformer-Historie @ 3\mod_1237373806926_79.doc @ 29846 @ 3  

5.3.5. Transmitter history 
Pos: 103 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer-Historie 635x @ 3\mod_1236082095561_79.doc @ 27272 @  
 

Parameterizations, adjustment processes and messages that have 
occurred are registered in the transmitter with an operating hours 
stamp. 
In the history overviews (explained later in more detail), past 
processes and events can be made visible. 

 

 
For parameter changes or adjustments that are performed 
directly at the instrument (via the user menu), "Transmitter" 
is entered in the User field and only the operating hour is 
entered in the Date/time field instead of operating 
hour/date/time. 
For entries that are performed using the P2A software, the 
name of the user logged into Windows appears in the User 
field, while the date/time and operating hour are shown in 
the Date/time field. 

 

1. Mark the instrument file of the connected instrument. 
2. Click on the [Transmitter history] button. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Transmitter history register. 
3. Click on the required entry in the list to change the display. 
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Field Explanation 

 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Comments Type of parameter change, e.g. "Unit of 
channel 1 from Pa to bar". 
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Field Explanation 

Selection: Analog adjustments. 

Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Unit Unit during the adjustment. 

Channel Analog adjustment: Channel 1 to n. 

Specification Analog adjustment: Actual value. 

Pressure 
specification 

n-point adjustment: Reference value set at 
the pressure sensor. 

Multimeter Analog adjustment: Reference value set at 
the multimeter. 

Offset Analog adjustment: Deviation at time of 
adjustment. 
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Field Explanation 

 
The table is shown only for error and status messages that were 
generated in the transmitter and were transferred and saved there 
via the connection to the P2A software. 
Operating hour Operating hour at which the message 

appeared in the instrument. 
Message e.g. "Watchdog error". Due to a processor 

error, the transmitter performs an automatic 
restart. 

Type of message e.g. early warning, status message. 
 

> To print out the history data, click on [Print]. 
 

 
The printing job is automatically sent to the default printer 
for the operating system. 
The printout can be edited using [Set up printer …]. 

 

4. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 104 /TD/Überschriften/8. Tipps und Hilfe @ 0\mod_1173789887985_79.doc @ 406 @ 1 
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6 Tips and assistance 
Pos: 105 /TD/Überschriften/8.1 Fragen und Antworten @ 0\mod_1177402017078_79.doc @ 1093 @ 2 
 

6.1. Questions and answers 
Pos: 106 /TD/Tipps und Hilfe/Fragen und Antworten/MUF 635x @ 3\mod_1236607627223_79.doc @ 27543 @  
 

Question Possible causes/solution 
Connection to instrument 
cannot be established 

Check connection cable/plug contacts

A message appears on the 
display 

See Status, warning and error 
messages, page 47  

Malfunction (with and 
without display) 

Analysis using the P2A software, see 
Analyzing/testing the transmitter, page 
68  

When does a stable 
current reading appear? 

After approx. 20 seconds 

  

If we could not answer your question, please contact your dealer or 
Testo Customer Service. For contact details see the rear side of 
this document or the web page www.testo.com/service-contact 

Pos: 107 /TD/Überschriften/8.2 Zubehör und Ersatzteile @ 0\mod_1177402058734_79.doc @ 1102 @ 2 
 

6.2. Accessories and spare parts 
Pos: 108 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Zubehör Ersatzteile MUF 635x @ 3\mod_1235640016819_79.doc @ 26783 @  
  
 

Description  Article no. 
Ethernet  
Ethernet module 0554 6656 
Ethernet connector 0554 6653 
Interface and software  
P2A software (parameterizing, adjusting, 
analyzing) incl. USB adapter 

0554 6020 

Plug-in connections  
Set of M12 plug-in connections (connector 
and socket) for power and signal lines 

0554 6682 

Hoses  
Silicone hose ID 4 transparent 0086 0001, sold by 

the metre 
TYGON hose ID 4.8 transparent 0086 0031, sold by 

the metre 
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Description  Article no. 
Pitot tubes  
Pitot tube, length 350 mm, stainless steel  0635 2145 
Pitot tube, length 1000 mm, stainless steel 0635 2345 
Supply  
Mains unit (desktop, wall-mounted) 0554 1748 
Mains unit (top-hat rail mounting) 0554 1749 
External display  
Process display for testo 54-2 AC.... 5400 7553 
Process display for testo 54-7 AC.... 5400 7555 
Calibration  
Standard ISO calibration certificate, 
transmitter only 

0520 1000 

Standard DKD calibration certificate, 
transmitter only 

0520 1200 

For a complete list of all accessories and spare parts, please refer 
to the product catalogues and brochures or look up our website at: 
www.testo.com 

 Pos: 109 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Bestelloptionen MUF 6350 @ 3\mod_1234275254948_79.doc @ 24242 @ 3 
 

6.2.1. Ordering options for testo 6351 transmitter 
(0555 6351) 

 

Order code  Characteristic 
Axx Measuring range  
A02 0 to 50 Pa 
A03  0 to 100 Pa 
A04 0 to 500 Pa 
A05 0 to 10 hPa 
A07 0 to 50 hPa 
A08 0 to 100 hPa 
A09  0 to 500 hPa 
A10 0 to 1000 hPa 
A11 0 to 2000 hPa 
A22 -50 to 50 Pa 
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Order code  Characteristic 
A23 -100 to 100 Pa 
A24  -500 to 500 Pa 
A25 -10 to 10 hPa 
A27 -50 to 50 hPa 
A28 -100 to 100 hPa 
A29 -500 to 500 hPa 
A30  -1000 to 1000 hPa 
A31 -2000 to 2000 hPa 
Bxx Analog 
output/supply 

 

B02 0 to 1 V (4-wire, 24 V AC/DC) 
B03 0 to 5 V (4-wire, 24 V AC/DC) 
B04 0 to 10 V (4-wire, 24 V AC/DC) 
B05 0 to 20 mA (4-wire, 24 V AC/DC) 
B06 4 to 20 mA (4-wire, 24 V AC/DC) 
Cxx Display  
C00 Without display 
C02 With display/English 
C03 With display/German 
C04 With display/French 
C05 With display/Spanish 
C06 With display/Italian 
C07 With display/Japanese 
C08 With display/Swedish 
Dxx Cable entry  
D01 M16 cable entry (relay: M20) 
D02 Cable entry NPT 1/2" 
D03 Cable contacting via M plug-in connection 

for signal and supply 
Exx Ethernet  
E00 Without Ethernet module 
E01 With Ethernet module 
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Order code  Characteristic 
Fxx Differential 
pressure unit 

 

F01 Pa/Min/Max 
F02 hPa/Min/Max 
F03 kPa/Min/Max 
F04 mbar/Min/Max 
F05 bar/Min/Max 
F06 mmH2O /Min/Max 
F07 inchH2O /Min/Max 
F08 inch HG/Min/Max 
F09 kg/cm2 /Min/Max 
F10 PSI/Min/Max 
F11 m/s /Min/Max 
F12 ft/min /Min/Max 
F13 m3/h /Min/Max 
F14 l/min /Min/Max 
F15 Nm3/h /Min/Max 
F16 Nl/min /Min/Max 
Hxx Relay  
H00 Without relay 
H01 4 relay outputs, limit value monitoring 
H02 4 relay outputs, channel 1 limit values 

and collective alarm 
Kxx Languages of 
instruction manual 

 

K01 German/English instruction manual 
K02 French/English instruction manual 
K03 Spanish/English instruction manual 
K04 Italian/English instruction manual 
K05 Dutch/English instruction manual 
K06 Japanese/English instruction manual 
K07 Chinese/English instruction manual 
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Order code  Characteristic 
K08 Swedish/English instruction manual 

C 

 
=== Ende der Liste für Textmarke Inhalt === 
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